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Chapter 1   Introduction      

Welcome to SigCalRP calibration software for SigGenRP projects. We hope 
you will find this software friendly and useful. As always, we welcome your 
comments on how to improve our software to make it more useful for your 
research. 

SigCalRP Overview   
SigCalRP is designed to make speaker calibration and generation of SigGen 
normalization files a simple process. SigGen normalization files can be used to 
flatten non-linear frequency responses of speakers.  

SigCalRP Capabilities   
SigCalRP plays out a series of tones and measures the sound pressure level 
(SPL) from a signal that is recorded using a calibrated microphone and digitized 
by an A/D converter. SigCalRP will then automatically calculate a 
normalization file that maximizes the signal to noise ratio of the D/A converter, 
while avoiding clipping. 

SigCalRP gives you two ways to normalize a signal:  

 normalization file in SigGenRP 

 normalization with a PA5 programmable attenuator (only use with tone 
signals) 

Each method has inherent advantages and disadvantages and only one method of 
normalization should be used. One of the keys to successful calibration is 
knowing the limitations of hardware, and how to avoid common pitfalls. These 
are briefly described in this manual and more information on System 3 hardware 
is available in the TDT System 3 Manual. 

Hardware Support   
SigCalRP supports TDT's System 3 RP family of Real-Time Processors as well 
as the RX6, RX8 and RZ6 processors: 

RP2 Real-Time Processor 
RP2.1 Enhanced Real-Time Processor 
RV8 Barracuda 
RL2 Stingray Pocket Processor 
RA16 Medusa Digital Bioamp 
RM1 Mini Processor 
RM2 Mobile Processor 

RX6 Piranha Processor 
RX8 Multi I/O Processor 
 
RZ6 Multi I/O Processor 
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Before You Begin:   
Before you begin you should have a basic knowledge of: 

SigGenRP concepts: you should be familiar with generating signals using 
the Frequency method in SigGenRP. 

Your RP device:  you should read the sections of the TDT System 3 
Manual for your processor device. Each device has 
different maximal sampling rates, and may have 
different maximum input and output voltage levels.  

 



 

Chapter 2   The Software Interface      

This chapter introduces the SigCalRP interface, menus, and dialog boxes. 

SigCalRP Plots 
The main SigCalRP workspace, shown below, is divided into three plot areas.  

 The Time Waveform shows the time domain plot of the recorded 
signal. 

 The Power Spectrum shows the frequency domain plot of the recorded 
signal. 

 The Calibration plot shows the speaker calibration, normalization 
curve, normalization curve test data, and total harmonic distortion 
(THD) measurements. 

To inspect different frequencies after the calibration is completed, right-click on 
the calibration plot. The Time waveform and Power spectrum will be updated 
for the frequency that is clicked.  

 

Screen Controls 

Zooming the Time and Frequency Plots 
Zoom in on a plot by clicking the left mouse button and dragging to the right. To 
zoom out, click the right mouse button while it is in the plot area. 
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Zooming the Calibration Plot 
The dB SPL scale may be manually zoomed out by left-clicking in either the 
upper or lower part of the scale to change the maximum and minimum plot 
values.  

Right-click in the scale to zoom in on the plot. 

Autoscale may also be used to automatically scale the plot. 

Moving the Normalization Line 
The green normalization line may be moved by pressing and holding the left 
mouse button while dragging the line to a new position. 

Inspecting Individual Frequencies 
To inspect the time and frequency plots of different frequencies, right-click the 
frequency you wish to view in the calibration plot. The current frequency being 
displayed is shown in the upper right corner of the frequency plot. Only the last 
100 frequencies tested are stored in memory. 

Menus 

File Menu 
The File menu includes commands for opening and saving SigCal files. SigCal 
files have the .cal extension and contain all of the SigCalRP settings as well as 
the data for SigCal files that have been run. Note that the functions to export 
normalization files and to export calibration data to an ASCII file are found 
under the Calibrate menu. 

New   Opens a new SigCal file with no calibration data. Previous SigCalRP 
settings are maintained. 

Open/Save/Save As   These commands will open and save all of the settings 
and calibration data in a SigCal file. The most recent SigCal files are shown at 
the bottom of the File menu. 

Print/Print Setup   These commands are used to print the current SigCalRP 
screen. The size of the plot on the printer is directly proportional to the size of 
the SigCalRP window. So, to increase the size of the plot, maximize the 
SigCalRP window. 

Exit   Exits the SigCalRP program. 

Calibrate Menu 
Start   Once the calibration signal and acquisition have been configured, Start 
plays the calibration tone series and begins acquisition and analysis. While 
calibration is in process, the signal values can not be changed. Click Stop before 
changing any settings. 
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Stop   Stops calibration procedure. If a calibration series is not complete, there 
may be invalid data for the rest of a series. When generating normalization files, 
be sure to run the calibration through the entire frequency series. 

Test Norm   Runs through the calibration series and applies the normalization 
data to the calibration tones. This allows you to test whether the normalization 
file will work in SigGenRP. The dotted lines produced by the test normalization 
series should be close to the green normalization line. 

Iterate   Runs through the calibration series and applies the normalization data 
to the calibration tones. The normalization data will then be adjusted to account 
for any deviations from the normalization line. Iterate may be run several times 
in a row to try to improve matching to the normalization line. 

Autoscale   Autoscale will scale the left hand y axis to the minimum and 
maximum of the calibration curves. 

Save Norm   Saves normalization data to a SigGenRP normalization file 
(*.nrm). 

Export Calibration Data   Saves calibration data to an ASCII text file that may 
be imported to a spreadsheet. The calibration data includes the SigGenRP 
calibration value, the calibration without normalization calculated from both the 
time signal and power spectrum. The total harmonic distortion measurement, 
and the normalization curve. If a test normalization is run, these data are also 
saved to the data file. 

Export Raw Data   Saves raw data from time signals and power spectra from 
all of the frequencies tested to two separate files. The time signal data are saved 
as volts and the power spectra as dB SPL. It takes several seconds to save the 
data. A maximum of 100 time and frequency buffers may be saved. If more 
frequencies were tested, only the last 100 will be saved. 

Save SigGen File   If a SigGenRP variable is used to generate the tone 
frequency series, the calibrated value determined by SigCalRP can be saved to 
that SigGen file or a new SigGen file. For example, if SigCalRP determines that 
9.0 V = 105.5 dB. This calibration may be saved to the SigGen file by choosing 
Save SigGen file. This would modify the calibration values that you see in the 
SigGenRP Signal dialog box (opened by choosing Signal from the Modify menu 
in SigGenRP). 

Save Variable Schedule File   Saves a variable schedule file that contains two 
variables: Freq and CalAtten. This schedule file can be used to calibrate a 
frequency series in SigGenRP through the use of a programmable attenuator. It 
is not useful for non-tonal signals, like noise. The schedule file will list each 
frequency tested and the amount of attenuation needed to calibrate that 
frequency. The schedule file will also contain header information about the 
calibration values that should be set in SigGenRP (note: these will not be set 
automatically), and the date and time the schedule file was saved. 

View Menu 
Time Signal SPL   When checked, plots the SPL measured from the time 
domain signal in yellow. This SPL measurement will often be higher than the 
SPL measurement from the power spectrum (shown in blue) due to background 
noise outside the frequency band measured. 
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THD   When checked, the THD values are plotted as brown squares on a scale 
of 0 to 2%. If Normalization Curve is also plotted, the THD scale will not be 
shown. THD is calculated using the first four harmonics of the test signal. 

Normalization Curve   When checked, the normalization data that are applied 
to the test signal are plotted as a purple line. The y scale for the normalization 
curve is shown on the right and is automatically scaled. 

Toolbar  Shows the toolbar. 

Status Bar   Shows the status bar. 

Setup Dialogs 

Signal Setup 
The Signal Setup dialog box is used to setup the calibration tone voltage and 
frequency series. The frequency series can be set through the Manual Frequency 
Settings or by using a frequency variable from a SigGen file. 

 

Manual Frequency Settings 

These settings are used to produce a series of tones whose SPL will be 
measured. 
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Tone Volts (peak) 

The peak voltage (i.e. not rms voltage) of the calibration tones. The D/A have a 
maximum peak voltage of 10V. This value is used for generating the test signals 
for either the Manual Frequency Settings or SigGen Frequency Settings. 

Frequency Start 

The first frequency of the calibration tone series. 

Frequency End 

The last frequency of the calibration tone series. 

Frequency Step 

The step value used to generate the tone series. The tone series may consist of a 
maximum of 1000 frequencies. 

Multiplicative Step Check Box 

Not checked...   the step value is a linear step. Note: the Frequency End value is 
inclusive. 
 
For example, if Frequency Start is 1000, Frequency End is 10000, and 
Frequency Step is 1000, the frequency series will be: 1000, 2000, 3000, ..., 
10,000. 

Checked...   the step value will be used as a multiplier. Note: the Frequency 
End value is non-inclusive. 
 
For example, if Frequency Start is 100, Frequency End is 6401, and Frequency 
Step is 2, the frequency series will be: 100, 200, 400, 800, 1600, 3200, 6400. 

Stimulus Device Setup 

These setting are used to configure the RPx device that will be used to generate 
the signals. It will load the appropriate RPvds file to the device for stimulus 
generation. The same or different RPx device may be used for acquisition. 

Sample Rate 

The sample rate for the D/A and A/D converters (they both must be the same for 
calibration). The maximum frequency that may be used for the frequency series 
is one-half of the sample rate.   

RP Device 

Selects the RP Device type. 

Device # 

Selects the device by logical index number. Device numbers can be viewed 
using the zBusMon utility. 
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SigGen Frequency Settings 

A frequency series may also be specified by loading a SigGenRP signal and 
choosing a variable that contains the values of the frequencies you want tested. 
It is important to note that the SigGenRP signal will not be used in the 
calculation. Instead, a series of tones will be generated with each tone's 
frequency specified by the selected SigGenRP variable. The amplitude of the 
tone is set in the Tone Volts edit box in the Manual Frequency Settings section. 
When a SigGen file is used the manual settings that can not be adjusted are 
grayed out. The sample rate is set to the sample rate specified in the SigGen file. 
The start and stop frequencies are determined from the SigGenRP variable and 
listed in the manual settings section.  

Use SigGen Signal Variable for Frequency Settings Check Box 

Enables or disables the use of SigGen Frequency Settings. 

Not checked...   The settings in the Manual Frequency settings area are used. 

Checked...   Frequency settings will be loaded from the specified file and 
variable. 

Load SigGen File 

Specifies the SigGen File to be used to select a variable. 

Select Frequency Variable 

Specifies the variable to be used for the frequency settings. 

Acquisition Setup 
The Setup Acquisition dialog box is used to configure the A/D converter, 
configure options for averaging, and to set the microphone calibration and gain. 
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# Averages 

Enter the value for the number of sweeps that will be acquired and averaged to 
obtain the calibration measurement. More sweeps will reduce the influence of 
background noise that is not produced by the transducer. 

Drop First Sweep 

Check this box to drop the first sweep and not include it in the overall average. 
Since the D/A and A/D start converting simultaneously, the time it takes the 
signal to reach the microphone will be recorded as no signal, if the first sweep is 
included. By dropping the first sweep, the effect of this travel time on the 
calibration value is minimized. 

AC couple 

Check this box to remove any DC shift from your signal. This is done 
mathematically after the signal is acquired. 

FFT Points 

This is the number of points used by the inverse FFT to generate the signal and 
the number of points used by the FFT to calculate the power spectrum. A larger 
number of FFT points will produce a longer test signal with greater frequency 
resolution. 

A/D Channel 

Selects which A/D channel is used to acquire the signal. 

Acquisition Device 

This section is used to select which device is used for acquisition. The same 
device may be used for both acquisition and stimulation, except when the 
sample rate is 200 kHz. 

Microphone Calibration 

Enter the value for the microphone calibration here as the number of millivolts 
produced by the microphone for a given SPL. This value is typically provided 
by the microphone manufacturer. 

Microphone Gain 

Enter the amount of gain on the microphone before the signal is sent to the A/D 
converter. Do not enter any gain that is already accounted for by the microphone 
calibration you entered. 

The gain value may be specified as either linear by checking 'x' or as logarithmic 
by checking 'dB'. For example a value of 100 with 'x' checked corresponds to 
100x gain. A value of 100 with dB checked corresponds to 100 dB gain. 

SigCalRP assumes that the microphone response is flat.  

SigCalRP uses this value to calculate the voltage output of the microphone and 
then uses the microphone calibration data provided above to determine the dB 
SPL at the microphone tip. 
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Chapter 3   Running a Calibration 

Calibration Fundamentals 

D/A Converters 
It is important to understand how the D/A converter (DAC) on your 
real-time processor generates signals and how to best take advantage of 
the DAC for high signal quality. Different processor devices have 
different bit resolutions and different maximum voltage outputs.  

We will discuss the RP2.1, RX6, and RZ6 here, because they are 
commonly used to generate stimulus signals. 

The RP2.1, RX6, and RZ6 

The RP2.1 ,RX6, and RZ6 DACs can generate a maximum signal of 
+/- 10V peak-to-peak. This signal is generated digitally with 24-bits, 
meaning there are 224 discrete values that the DAC can generate to 
represent different voltages. This gives the DAC about a 144 dB 
theoretical dynamic range between the smallest and largest signal that 
can be produced. In practice, the signal to noise ratio on the RP2.1 is 
about 105 dB. 

It is best to try to generate the largest signal possible out of the DAC. 
This will give you the best signal to noise ratio, and also lets you take 
advantage of the full dynamic range of the DAC. 

Signal-to-Noise Ratio 
All electrical systems have some level of noise in them. The noise 
coming out of the DAC is the same whether you are generating a 9 V or 
a 9 mV signal. Therefore, the signal to noise ratio of your signal will be 
higher the closer you get to the 10V maximum of the DAC. 

Clipping 
If you try to generate a signal larger than 10V, the DAC will clip the 
signal. That is, the peaks of the signal that exceed 10V will be set to 10 
V, and your signal will not be faithfully reproduced. 

How Normalization Files Work 
The purpose of normalization files is to flatten the frequency response 
of the speaker by adjusting the voltage of the digital signal that is 
played out of the D/A converter. In SigGenRP, the normalization curve 
is added to signals generated in the frequency domain to produce the 
normalized time signal, which is then played. 
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Since the dynamic range of the DAC is 144 dB, this is the theoretical 
maximum range that a normalization curve could have before there was 
clipping or no signal was produced by the DAC. However, if you 
normalize down 90 dB, that only gives you 54 dB worth of dynamic 
range. A tone could then only be made with a handful of discrete 
values, and its quality would be diminished. Thus, it is best to 
normalize over a smaller range of the DAC, around 30 dB. SigCalRP 
has built in warnings for indicating that a signal will clip or be too 
small. 

Using a PA5 Programmable 
Attenuator to Calibrate a Tone Series 
If your SigGenRP signal consists of a single tone where the frequency 
may vary over separate SGI's, then you could use a PA5 to calibrate 
your signals instead of a normalization file. 

The advantages of using a PA5 for calibration include: 

 You can use either the Time or Frequency methods of signal 
generation in SigGen. 

 The signal-to-noise ratio of all of the frequencies tested will be 
the same. 

 You can play a large signal out of the DAC and use the wide 
dynamic range of the PA5 to calibrate the signal over a larger 
range. 

SigCalRP will generate a Variable Schedule File containing values that 
should be sent to the PA5 at each frequency to calibrate the signals. 

Configuring Signals and Acquisition 

Signal Setup 
Open the Signal Setup dialog from the Setup menu to configure the 
range of frequencies that will be tested. The default test level is 9 V to 
maximize the dynamic range of the DAC. Set the start and stop 
frequencies to cover the entire range that you will want to use. Use a 
large step value for a quick first run to see how flat the speaker is over 
that frequency range. This can later be set to a smaller value to produce 
the normalization file. 

Acquisition Setup 
For the initial run, use the default settings in the Acquisition Setup 
dialog. This will allow you to quickly estimate how flat the speaker is. 
For the final run, you can increase the number of averages and FFT 
length to get a more precise calibration. 

Enter the microphone calibration for your microphone and amplifier. It 
is important that you have a microphone with a known calibration. The 
accuracy of the calibration depends on the accuracy of the microphone. 
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Hardware Configuration 
The figure below shows a typical hardware setup using an RP2 to 
perform the calibration of a speaker. Other hardware setups are 
possible. 

 

There are generally two signal paths: 

 Signal Presentation: This is the path from the processor device 
Output to the speaker or other transducer. There may be other 
modules in this path, such as an HB7 Headphone Buffer or 
SA1 Speaker Amplifier. 

 Signal Acquisition: This is the path from the microphone (or 
other measurement device) to the processor device Input.  
There may be other modules in this path, such as the MA3 
microphone amplifier. 

Running the Calibration 
Once the signal and acquisition are configured, make sure the TDT 
hardware is configured as you will use it in your experiment. Connect 
the DAC to the amplifier and speaker that will be used in your 
experiment. Connect the microphone to the microphone amplifier and 
then to channel 1 of the A/D converter.  

Run the Calibration 
To start the calibration, choose Start from the Calibration menu, or 
click on the Play button on the toolbar. The calibration may be run 
several times if you need to adjust the speaker amplifier, microphone 
amplifier, or experimental setup. 
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Setting the Calibration Level 

  

The calibration level is the value that will be used to calculate the 
normalization curve. It is represented by a green line on the calibration 
plot. If the SPL at a given frequency is greater than the calibration 
level, this will result in a negative normalization value. Likewise, if the 
SPL is less than the calibration level, this will result in a positive 
normalization value that will be added to the signal to boost it so that it 
equals the calibration value. 

After the calibration is run, the calibration level will be automatically 
set as high as possible so that the resulting normalization curve does 
not produce clipping in the DAC when it is used in SigGenRP. 

The calibration level will give you the calibration value to use in 
SigGenRP. For example, if a 9V test signal was used, the calibration 
may say 9V = 110 dB. As you adjust the line, you will see this 
calibration value change. 

Changing the Calibration Level 
In most cases you will find that the calibration level is set just as you 
need. To change the calibration level, left-click on the green calibration 
line and drag it to a new value. A new normalization curve will be 
calculated based on the calibration line. 

Clipping 
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If you set the calibration level too high, so that the normalized signal 
would be clipped (i.e. the normalization curve would cause the signal to 
be larger than 10V), red squares will be placed on the calibration curve 
at frequencies that will be clipped. 

Too Much Attenuation 
 

 

If you set the calibration level too low, so that the output signal would 
be less than 0.1 V, green squares will be placed on the curve. 

Viewing the Normalization Curve 

 

To view the normalization curve, select Normalization Curve from the 
View menu. The normalization curve will be autoscaled so that it is 
maximized on the plot. The scale for the normalization curve is labeled 
on the second y axis, and will be plotted in a fuschia color. 

Testing the Calibration 
Once the calibration has been run and the normalization curve 
generated, you can test the normalization curve. Select Test Norm from 
the Calibration menu. This will use the normalization curve to adjust 
the signal produced by the DAC. 

The level of the sound will be plotted as a dotted line. If the 
normalization curve is set properly, the dotted line should closely 
parallel the green calibration line. 
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Fine Tuning the Calibration 
If the calibration test shows that the normalization curve does not 
produce a flat response out of the speaker: 

1. Check to make sure that you are not overdriving the speaker. 
Look at the THD levels and the power spectra to make sure 
that you are getting a pure tone signal, and not a lot of 
harmonics. If you see a lot of harmonics, you either should 
turn down the gain on your speaker amplifier, or attenuate the 
signal from the DAC by sending it through a PA5 
Programmable Attenuator. 

2. Make sure that the microphone is not being overdriven, and 
that the amplitude of the signal coming out of the microphone 
amplifier is at least one volt (look at the voltage on the Time 
Domain plot), but not more than 10V. 

3. Try iterating the normalization test several times. This will 
adjust the normalization curve based on the deviations from 
the calibration level. 

4. Try re-running the entire calibration with more averages 
and/or a longer FFT. 

If you can't get one normalization file that covers the whole frequency 
range of the speaker without either clipping the signal or playing too 
small a signal out of the DAC: 

1. Break your frequency range into two parts, and create a 
normalization file for each section. 

2. You will also have to create a separate SigGen file with a 
different calibration for each section. 

Using Normalization Files in SigGenRP 
Once you have established the reasonable frequency range to use for 
your speaker, run the calibration with smaller steps, and test it. When 
you are satisfied that the normalization file produces a sufficiently flat 
response, save your normalization file by selecting Save Norm from the 
Calibration menu. 
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The file can then be used in SigGenRP by checking Use Norm in the 
Signal Parameters dialog box (opened by selecting Signal from the 
Modify menu), and then loading the normalization file. 

Be sure that to generate signals using the frequency method in the 
segment dialog box. Otherwise, the normalization file will not be 
used. 

Remember to change the calibration setting in SigGenRP to the value 
determined by SigCalRP. If a SigGenRP variable is used to generate 
the tone frequency series, the calibrated value determined by SigCalRP 
may be saved to that SigGen file or a new SigGen file from SigCalRP. 
For example, if SigCalRP determines that 9.0 V = 105.5 dB. This 
calibration may be saved to the SigGen file by choosing Save SigGen 
file. This would modify the calibration values that you see in the 
SigGen Signal dialog box (opened by choosing Signal from the Modify 
menu in SigGenRP). If you did not use a SigGen file to set up the 
frequency series, you would have to manually enter this calibration in 
SigGenRP. 

Using a PA5 Attenuator for Tone Calibration 

Calibration of Tone Signals 
Normalization files are of most utility for non-tonal signals. If you are 
using single tones as your SigGenRP stimuli, then you will obtain 
better signal quality if you use the PA5 Programmable Attenuator to 
equalize the different frequencies. SigGenRP normalization files adjust 
for the transducer variability by decreasing the amplitude of the D/A 
output. When tones are used, since you are only playing one frequency, 
you can use the PA5 to adjust the signal level. This will provide 
constant signal-to-noise ratio for all of the frequencies and let you 
maximize the output voltage on the D/A converter. 

Use the Save Variable Schedule File feature of SigCalRP to save these 
values to a variable file for use in SigGenRP. The values saved to these 
files will be the attenuations that need to be applied at each frequency 
to calibrate the signal. In SigGenRP, use this variable file to attenuate 
each frequency appropriately. 

The schedule file creates two lists of values, one for frequencies and 
one for the normalized attenuation level.  You must create two 
variables in your SigGen file and name them Freq and CalAtten.  Set 
each variable to use the "Schedule File" method and enter the name of 
the schedule file that you saved after calibration.  These two variables 
will use the list of values saved in the schedule file.  Select Preview 
Variables to confirm the correct values. 

Next you must link the appropriate signal parameters to these variables. 
In the Modify->Segment menu, the frequency of your tone segment 
should be set to the Freq variable.  In the Attenuation box located in the 
Modify->Signal menu, choose the PA5 device and select the CalAtten 
variable from the dropdown list.  See the SigGenRP help guide for 
more information. 
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